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Retalix BackOffice Release Notes 
Release:       4.04.00 
Date:                    February, 2005 
Goal of Release: General Release 
O/S Support:      Windows 2000 
                             Windows 2003 Server, Windows XP Professional 
DB Support:       SQL Server 2000 Standard Edition Service Pack 3 
POS Type ISS45 V7 ISS45 V8 ScanMaster NCR ACS 
Rel. Support 7.7, 7.8, 7.0.8, 7.0.9 8.4.6, 8.0.6, 8.0.8, 

8.1.0 
2.1 6.0 

                              
*  ISS45 refers to the release of Retalix POS sold through the dealer channels.  StoreLine is the Retalix POS sold to direct customers.  
This document refers to ISS45 but the two are treated the same. 
 

Installation/Update information 

General 
Internet Explorer 5.5 must be installed prior to installing RBO.  The installation is found on the 
RBO Installation CD in the \Other\Microsoft\Internet Explorer 5.5 folder. 
 
If the computer on which RBO Server is installed is not physically connected to a network, RBO 
services will not start and RBO will not run.  Be sure the RBO computer is connected to a 
network, even if only to a hub with no other active systems.  
 
Please ensure that a back up of the databases has been performed prior to executing an update.  
 
The RBO default user name is Admin.  You should add additional users through security 
maintenance.  See the RBO Users Guide for instructions. 
 
SQL Server Service Pack 3 is included on the Retalix BackOffice Installation CD in the 
\Other\Microsoft\SQL Server 2000 SP3a folder. 
 
Stylus has been upgraded to version 2.7.  Please update existing versions from the \Stylus folder 
on the RBO installation CD. 
 
A Stylus Patch has been included on the RBO installation CD.  Execute the install.bat file in the 
\Stylus\_Apply_this_patch_after_setup_ folder to apply the patch. 
 
Users are not automatically granted Read/Write/Execute permissions to shares in Windows 
Server 2003.  When installing Stylus and sharing the Insignia folder as per the installation 
instructions, you must modify the share permissions to allow users and administrators 
Read/Write/Execute permissions.  
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Installing RBO for ISS45 

V8 
RBO Server must be installed on MFS1.   
 
The ISS45/StoreLine parameter “Update All Mix and Match Groups When One PLU Changed” 
must be set to No.  If this parameter is set to Yes, the “Send PLU File to POS” will return errors 
before it is completed, will take many hours to complete and when the build completes, RBO and 
the POS will be out of sync. 
 
The following parameters must be set in ISS45: 

• General System Parameters 
o Store>Front Office>PLU and Batch>Batch Options 

! Use Fast PLU Batch Execution = Yes 
o Store>Front Office>PLU Options>Validation 

! Force short and long description to match = No 
o Store>POST>Monetary>Frequent Shopper>Frequent Shopper Mode 

! Frequent shopper type 
• Enhanced frequent shopper (type2) 
 

Reboot the system after making this change 
 
The PLU Maintenance and PLU Batch features from the PLU Management menu in ISS45 Office 
are removed from the menu system.  This is done to prevent data entry outside of RBO and keep 
the files synchronized. 
 
ISS45 Office Client must be installed where a RBO client is installed.  
 
To accommodate the additional disk space that movement history will require, it is recommended 
that RBO be installed on a large – 10gb or greater – partition. 
 
To accommodate existing servers that have a computer name that begins with a number, the host 
file must be updated to include an entry for MFS1 that corresponds to the server’s IP address.  
The entry should resemble: 192.1.1.10 MFS1 
 
SQL Server 2000 must be installed according to the ISS45/StoreLine Office Installation 
instructions.  Specifically, the Collation Settings must be set for Binary order for use with the 
850 (Multilingual) Character Set.  Failure to install SQL Server correctly will render the Fast 
PLU Batching feature in RBO incompatible with ISS45/StoreLine. 

V7 
RBO Server may be installed on MFS1, MFS2 or any stand-alone Windows 2000 server.  
The Retalix StoreLine Communications Repository must be installed on MFS1.  Refer to 
the Getting Started Guide for installation instructions. 
 
ISS45 Office Client must be installed on any RBO system where item maintenance will 
be performed. 



  RBO Release Notes 
  Release 4.04.00 

Page 6 of 28        RBO Release Notes 

 

Installing RBO for NCR ACS 
The software to communicate to the ACS server from RBO is provided in the 
\Other\RBO_ACS Communications folder on the Installation CD.  Installation 
instructions are provided in the file: ACS Communications Getting Started Guide.pdf. 

Installing RBO for NCR ScanMaster 
Please refer to the Configuring For ScanMaster 2.1.rtf file in the \Other\ScanMaster 
folder on the installation CD. 
 
Beginning with this release, RBO is no longer compatible with ScanMaster 1.2 or 2.0 due 
to architecture changes in ScanMaster. 
 
RBO replaces the functionality of Enhanced Pricing in ScanMaster 2.1.  You must 
disable Enhanced Pricing in ScanMaster when installing RBO. 

Updating RBO 
 
When updating RBO for ISS45, the RBO StoreLine Communications must be updated.  When 
RBO Server is installed on MFS1, the installation will automatically install or update the RBO 
StoreLine Communications application   If you are not installing RBO Server on MFS1 (V7 
only), you must install the StoreLine Communications application separately on MFS1.  The 
setup is found on the CD under Other, RBO StoreLine Communications.  Initiate the update by 
launching Setup.exe on the CD from the ISS45 POS Server. 
 
When updating RBO, if any FM Parameters include the field 72. pkg size, the parameter must be 
edited before using.  Field 72 has been renamed pkg count and will cause the FM application to 
crash, requiring a restart of the FM service. 
 
When updating RBO from 4.2.X or earlier to RBO 4.3.3, reports have changed significantly and 
existing queries may not be updated.  Please review the available reports and report queries.  
Rebuild new queries as required. 
 
After updating from RBO 4.2.X or earlier to RBO 4.3.3, the parameter “First Day of Movement 
Week” has been changed.  Two parameters, “Ad Week Start Day” and “Business Week Start 
Day”, replace the old parameter.  The default value for these parameters is Sunday.  The 
parameter “Business Week Start Day” should be changed to match the older “First Day of 
Movement Week” value so that weekly reports will start on the same date.   
 
When updating RBO for ACS, the RBO_ACS Communications must be updated.  This is found 
on the CD under Other\RBO_ACS Communications.  Initiate the update by launching Setup.exe 
on the CD from the ACS Primary and Secondary Servers.  
 
Due to changes in the Movement Extract For Host process, any extract Back Office Task will 
need to be recreated. 
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What's New in 4.04.00 

Item Maintenance Enhancements  

+/- Price Change 
o The Percent Price Change feature has been expanded to be a +/- Price Change, 

which includes changing by percentage or a dollar amount.  
• When the price is increased, the price is rounded based on the Item Price 

Rounding table (See page 224 of RBO Users Guide for details on Item 
Price Rounding) 

 

 
 

 
This feature may be used to increase or decrease a group of items through Mass 
Maintenance or by setting the change as a constant.   
For example: Re-price all the items within the Vitamin Department for a 5% 
decrease. 

Multiple Item Ignore 
o When multiple items are displayed in Grid, a user may highlight one or 

more item and select Ignore Item from the Edit menu to ignore all the 
selected items at one time. 
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Re-pricing by Target Gross Margin % 
o Automatic Re-Pricing by Target Gross Margin % is fully enabled 

• Re-pricing reflects the Pass-On Percentage, Rounding Rules (See Item 
Price Rounding) and Minimum Auto Price change 

• When the price is changed due to Automatic Re-Pricing, the field color is 
blue instead of red, indicating that the price changed automatically 

• A menu option “View> Price Calculation” will display the calculation 
used to determine the price change 

o Automatic Re-Pricing and +/- Price Change features are mass maintainable so 
that a group of items may receive the same calculation to regenerate the price 

 
 

 
 

 
 

Price Rounding Table View Price Calculation  

Set the Target 
GM%, Pass-on 
%, Min Auto 
Price Change 

The price is changed 
automatically to 
reflect new GM% 
and rounding rules

Original Price 

You can view 
the calculation 
used to generate 
the price 
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Simple Query Wizard for Reports 
o Users may now use the Simple Query Wizard to build queries for Item 

Maintenance reports 
• Queries may be saved from the Simple Query Wizard 
• Clicking the Advanced… button will launch the Query Builder window 

o Item Reports may be queried by all database fields 
 

 
 
Clicking OK populates the traditional query wizard window with selected options: 
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o Sorts and Filters may be saved with the query: 

 
 

User Defined Exports 
o User Defined Exports may be created and used as part of the reporting 

process. 
o To create an export file based on a report: 

o Choose the report to export 
o Define the query, sort and filter as desired 
o Enter the export file specifics 
o Choose the columns to export 
o Save query if you wish to reuse the settings 
o Print the report to the screen and export the displayed report using 

the   (Export) icon.  
o Any time a report is displayed, you may change or set the export 

parameters by clicking on the  (Export Options) icon. 
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Report Description Parameter 
o A new global parameter – Item Description to Use on Reports – Item 

Description or POS Description – sets the description that will print on all 
RBO reports.  This eliminates the need for multiple versions of the same 
report and maintains consistency between the descriptions used on the 
various reports 
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Item Contribution Report 
o The Item Contribution report has been split into two different reports – By Sales, 

By Profit 
• By Sales gives the contribution to Sales of the items in the group 
• By Profit gives the contribution to Profit of the items in the group 

Zero Movers By Date Range Report 
o This is a new report that will allow a user to report on items that did not move 

during a given date range.   

Promotion Contribution Report 
o This is a new report that will display the total movement and sales prior to 

subtracting any promotions applied to an item, the promotion movement 
and markdown amount for that item and the net sales after subtracting the 
promotion markdown. 

o The Net Movement and Sales is the movement and sales reflected on all 
other movement reports. 

 

 

Menu Reorganization 
o Menus in item maintenance have been reorganized 

• Pricing Details is under the View Menu 
• Pricing Calculation is under the View Menu 
• +/- Price Change, Calculate Price and Update Inventory Count are 

grouped with Mass Maintenance 
• Mass Maintenance, Calculate Price and +/- Price Change are on the 

Right-click Menu 

Edit Grid Columns Changes 
o Edit Grid Column Settings screen change 

• The Up and Down arrows work in Select Columns screen 
• The default key is OK. 
• Cancel button has been removed 
• Moved action buttons to the side of the screen 
• Added a Current column 
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Clear All Constants 
o A new menu option – Clear All Constants – has been added to the context 

(right-click) and Edit Menus.  This will clear all existing constants at one 
time. 
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Zero Padding on Order Code 
o When using the SIL Order Code Trim feature, the Order Code will be zero-filled 

to the left up to the Trim Order Code Size value when key-entering the Order 
Code.  This is to retain consistency between Item Maintenance data entry and 
SIL processing 

 

 
 

 

Item Group Code Pricing 
o Items group with the same 

price change 

 
 
 
 
 

o When you put the item awa

 
o Answering Yes adds the gr

change. 
o Choose Review Batch to re
o Make additional changes a

Key in 
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padded to mat
parameter

Price chang
group 99 
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   RBO Release Notes 
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Item Duplication 
o A new feature to add groups of new items quickly by selecting an existing 

item and ‘duplicating’ it with a new Item Number (UPC), POS 
Description and/or Order Code. 

o Query or add item to be duplicated. 
o Right-click the item and choose Duplicate Item... to see the following 

prompt: 

 
o Type the new UPC (required), POS Description and Order Code (if 

different). 
o Click on More Items or press Enter to continue to add more new items. 
o Click on Done to save last one and close dialog box. 
o Click on Cancel to exit dialog box without saving the current item. 
o The new item(s) are exactly like the original item except for the prompted 

changes.   
o Additional changes may be made to the items within the batch. 
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ScanMaster Department Flags 
o The display and maintenance of department flags has been enhanced 

within RBO Item Maintenance to provide the results of changing a flag 
whether the POS is configured to follow the department or the item. 

o A new global parameter – Item Status Information follows Item File or 
Dept File? – tells item maintenance how to display and handle overriding 
the department default. 

o An item’s flags depend on the department settings.  When the global 
parameter is set to follow the item (the default) and the item’s Dept 
Override is not set, the item, department and result flags will be the same 
and inactive: 

 
o If the Dept Override flag is checked and a flag is changed from the 

department default, the Result column will indicate the change: 

 
o If the global parameter is set to follow the department, the POS behavior is 

to treat the item flags as individual overrides, reversing the department 
settings.  RBO will display the result: 
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Stage and Release Performance Enhancements 

Item and Batch Staging 
Significant improvements have been made in the speed with which items are staged to be 
applied to the POS.  The changes will be evident both in individual item staging 
(Immediate Item Maintenance) and when staging batches. 

V8 Release Process for ISS45 V8.0.8+ 
Beginning with ISS45 version 8.0.8, the release process for releasing batches has been 
improved by taking advantage of the built-in Fast PLU Batch functionality of the V8 POS 
system.  These performance gains will be realized when releasing batches of more than 
500 items from Batch Manager or Release manager; releasing less than 500 items using 
this method will not result in the Fast PLU Batch feature, however, due to changes on 
ISS45 V8.1.0.0, the ActiveX apply has been improved so there will be some batch apply 
improvements over earlier versions of V8.  Immediate Maintenance and batches set to 
Auto Release during the stage process will not be impacted by these changes. 
 
Note: Due to limitations in the V8 General Batch process, if Price Lists are in use, the current (pre-4.4) 
release process will be used. 
 
Due to the nature of these changes, the progress bar will only be displayed when 
releasing batches with fewer than 500 items.  Instead animated icons are used for Stage 
and Release. 
 

Stage animated icon 

 

Release animated icon 

 
 
Performance gains are greater with bigger batches.   
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Host Support  

Host ID Maintenance 
o The ability to create User Defined Exports has been added to the Host ID 

Maintenance application. 

o New toolbar icons allow a user to build a new export:  (Add 
Export/Delete Export) 

o Use query builder to create and save the query/sort/filter/export 
information.  Since this is not based on a report, the user can choose 
exactly the columns to export in the order they wish. 

o Existing exports for the host are listed 

 
o The export is available under the new Back Office Task – Host Exports – 

and may be built and scheduled. 
 

SIL Batch Export 
o The ability to export previously imported SIL files using the SIL Batch 

Export Batches has been added 

SIL Support of Free Item Value for ScanMaster 
o A new BA field in the SIL dictionary – BA1033 – has been added to the 

SIL interpreter to set the Free Item flag in ScanMaster 

CIX Vendor File Support 
o An option has been created to allow dbconvrt.exe to automatically process 

an FX vendor file when received from CIX.   
o The file can be processed using the syntax: dbconvrt HXVendor Y 

SILSetBatchIgnoreFlag for Host batches 
o A new “hidden” parameter has been created that can be accessed by 

pressing CTRL-ALT-L called SILSetBatchIgnoreFlag that forces new 
batches received via SIL to be set to Ignore so they do not apply until 
explicitly un-ignored and staged/released. 
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o  

Label Printing 

Output Label Info to a Database Table 
o A new global parameter – Output Label Info to a Database Table – has been 

added to allow users to use non-Stylus ODBC compatible label printing 
programs to print shelf tags. 

 

Receiving  

Adjustments on invoices 
o Modified the invoice report so that when an adjustment, like a bottle or shell 

deposit, is configured not to affect GM%, the adjustment doesn’t affect Profit 
Dollars 
! Two new subtotals are added to the invoice: 

• Invoice Profit Subtotal 
• Adjs Excluded from GM% 

! The Invoice Profit will be the total adjusted profit + the adjustments 
marked as excluded from GM% 

Reports 
o The options for saving sorts/filters/exports with reports available in Item 

Maintenance are available in the Receiving Reports 
o Added the Supplier Category Description to the Supplier List report 

Menu Access to Invoice Import Log File 
o The Invoice Import Log File can now be accessed from within the Receiving and 

Invoice Import Maintenance menus. 

Hold Price Receiving 
o In a hosted environment, where maintenance is primarily or exclusively 

permanent, a method for receiving against the Hold Price as the regular price. 
o A new global parameter – Use Hold Price – has been added to enable this feature. 

 

Updating Cost when Importing Invoices 
o The ability to update the current cost of an item while importing an invoice has 

been added to the system. 
o A new supplier attribute – Accept Invoice Cost – will indicate that as an invoice 

is received through XML, the cost on the invoice will be checked and if it is 
different from the current base cost of an item, it will be added to the item with 
the current date as the start date. 

o This feature is limited to base costs does not include allowances.
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Inventory Management  

Import of Flexible Data Collect files 
o New FM Flexible Data Collect parameters are provided for the Store Transfer 

Out/In, Department Transfer, Record Store Use and Record Waste features of 
Inventory Management. 

o An import feature is written to read these files on a /Q of the parameter. 
o Reports are printed automatically for Store Transfers (Out or In) 
 

Stock Count Maintenance  

Import of RGIS inventory files 
o An option to import inventory counts into Stock Count Maintenance has 

been provided for those who use 3rd party inventory services 

Valuation Reports by Session 
o A new report for the Valuation Reports has been added that does not 

group the items by Supplier.  The entire session is printed without 
interruption. 

 

FM Enhancement  

FM Flexible Data Collect 
o The FM Flexible Data Collect Options tab has been redesigned for clarity 
o FM Flexible Data Collect now has the ability to print following a /GO or 

/QUIT command 
! The output file will be the raw data collect file 

o The file pathname created by FM Flexible Data Collect can be passed to 
the application to execute following a /Quit by adding %f% as an 
argument in the Parameters line: 
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o You may use the “Retalix\Backoffice” folder as the root of your path to 
reduce path typing and make the system “blind” to the drive letter.  To do 
this, place the argument %ROOTDIR% at the beginning of your path: 
! Ex: %ROOTDIR%\Instore\ItemMaintenance  

o Six new FM Flexible Data Collect parameters have been provided for 
Inventory Management.  These have been specifically created to work 
with the import feature of Inventory Management and should not be 
changed.  The new parameters are: 
! Store Transfer Out – Used to create a Store Transfer – Report 

prints 
! Store Transfer In – Used to receive a Store Transfer using Current 

Cost – Report prints 
! Store Transfer In With Cost – Used to receive a Store Transfer but 

the user enters the cost manually – Report prints 
! Department Transfer – Transfers an item’s inventory to a different 

department – Report does not print 
! Record Store Use – Records Store Use and decrements inventory – 

Report does not print 
! Record Store Waste – Records Store Waste and decrements 

inventory – Report does not print 

ISS45 Release Compatibility 
As RBO is enhanced, certain features require enhancements to the POS before they will 
work properly.  The table below describes those features that require specific POS 
releases.  The releases given below indicate the minimum version of software to use the 
new feature.  
 

ISS45 ISS45 Rel RBO Rel ISS45 Rel RBO Rel
Display of Promotion Data with Launch to Promotion Manager 8.4.2.58 4.2.0 7.0.8.3 4.2.1
Creation and management of Simple Promotions through RBO. 8.0.6 4.3.0 7.0.9 4.3.3
Price List support from within RBO 8.0.6 4.3.0 N N
X for Y$ Frequent Shopper type support 8.0.8 4.3.1 7.0.8.3_56 4.3.1
Comparative Price Frequent Shopper Type support N N 7.0.8.3_56 4.3.1
Unit Price Field Support for ESL 8.0.6.0_55 4.3.1 7.0.8.3_56 4.3.1
Fast Batch Release 8.0.8 4.4 NA 4.4

ScanMaster POS Version 4.1 4.2 4.3 4.4
ScanMaster 1.2 (DOS) Y Y Y N
ScanMaster 2.0 (Windows) Y Y Y N
ScanMaster 2.1 (Windows) N N N Y

RBO Release
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Resolved Issues 
 
Defect # Defect Description 
490 Resolved a problem where the POS Unit Size was not being sent correctly to 

ScanMaster 
528 Changed the help for the POS Commodity Code field. 
546 Changed Item Maintenance to protect the Limited by Qty, Limited by Price, Pos Split 

Qty and POS Split Price fields when editing an NSC-2 item for ScanMaster 
551 Resolved a problem where a File Sync was not properly handling items in a temporary 

batch 
563 Removed fields that are not editable in screen maintenance, like First Sold Date etc., 

from the FM Parameter lists so the user may not change them. 
577 Resolved an SQL error in Grid View when invalid data was entered in certain fields. 
959 Newly created selection criteria is now the default when returning to the print 

specifications window to print a report 
1849 On-hand inventory is not decremented for items marked as Negative or Coupon Item 
1108 FM login failure gives a more generic error – Login Failed – instead of Invalid User.  
2171 Changed dbconvrt.exe to behave like SIL when trimming the Order Code to desired 

length.  For the present, the behavior will be based on the registry setting: 
...\System\Item Maintenance\FileConvert_Order_Code_Length 

2248 Changed SIL processing so that cost is updated properly when the cost field is sent in 
both the item_dct and the fcost_dct views 

2253 Provided updated documentation for installing RBO Client on an XP system 
2254 Resolved a problem where a new order package was added to an item but the item 

was inadvertently deleted but the Order Package was still in the system 
2287 Changed Grid View so the screen returns to the far left column when entering data 

and pressing enter to finish and go to the next line. 
2288 Resolved a problem in Item Maintenance where a Price Multiple of 0 caused a 

program termination 
2298 Changed the No Coupon Mult flag logic to follow ScanMaster logic.  This includes 

making the flag inactive when the No Coupon flag is Y 
2299 Changed the File Synchronization program to trim spaces when checking the POS 

descriptions to prevent inadvertent synchronization on these fields 
2304 The ability to unlink a non-member promotion (Promotion/Reduction/Offer) from 

within RBO has been disabled.  Only Promotions to which a user can link can be 
unlinked. 

2314 Resolved a problem where the Vendor Cost Sheet Validation report would hang and 
not complete 

2316 Changed the rounding calculation within the RBO reports for ScanMaster to more 
closely match the dollar totals reported by ScanMaster sales.  

2319 Resolved an issue where the Invalid Receiving Day warning was causing the FM 
application to ‘lose itself’ when receiving items 

2327 Resolved a problem where maintenance was not always being flagged as “needs 
attention” – Orange in batch manager. 

2345 Changed logic to consider the scale flag when setting thresholds while saving certain 
promotions 

2346 Resolved a problem where deleting costs/adjustments used all CPU time and never 
completes 
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2355 Invoice import was not adding a record for an item if there were multiple order 
packages and the Order Code was not sent on the invoice.  This has been corrected 

2360 Changed Release Manager to print items in UPC order. 
2363 Changed behavior in Unit Price Category Maintenance to start in Insert mode if there 

are no rows in the database. 
2375 Resolved a problem with SIL Batch Export where the Units/Case and Quantity 

Prohibit were not being written to the exported batch 
2378 Changed the SIL Batch export application to omit commas within the batch 

description so they do not create problems in a SIL parser 
2380 Added the ability to export the Target Gross Margin % in SIL Batch Export 
2384 In 4.3.3, a patch was provided to update the progress bar in Batch Manager when 

applying batches that updated per item.  Due to the changes listed above for Staging 
and Releasing, the progress bar only appears when Releasing items using ActiveX.  
When using Fast PLU Batching (releasing 500 or more items) or Staging, animated 
icons replace the progress bar. 

2387 Resolved a problem where duplicate adjustments were being added under certain 
conditions when processing SIL. 

2389 Resolved a problem where certain fields were not being saved when adding a new 
adjustment 

2392 Changed the wording of the save prompt when a grids width or column placement to: 
“...Do you want to save the changes to the settings?” 

2394 Added the ability for a Vendor file from CIX in FX to be processed automatically.  To 
do this, a batch file running dbconvrt and passing the filename should be created and 
executed using File Router to move and execute the batch file. 

2396 Changed the logic regarding the processing of the Tare Code value when an item is 
received via SIL.  If an item is not a weighed item and a Tare Code is set, the Tare 
Code is set to 0 – None 

2401 Changed dbconvrt to follow the same logic as described above with the Tare Code 
2404 Changed the handling of the tare weight and decimal quantity: 

o If tare weight is set to 0, the weighed flag is not automatically set to N 
o If decimal qty is changed to Y, then set the weighed flag = N and dare 

weigh t = 0 
o If tare weight is changed to > 0, the set the weighed flag = Y and 

decimal qty = N 
2406 Resolved a problem where certain fields were not being saved when adding a new 

order package. 
2414 Resolved a problem where the File Synchronization application would give error 

when it encountered an item with the Dept. Override set to N. 
2417 Changed the calculation of Gross Margin where a large GM% be capped at  –100%. 
2430 Changed handling logic of department itemizers when adding  or changing items 

through SIL: 
o If the item is being added or the department is being changed, or the 

Dept Override flag in the SIL file is N, department itemizers will be 
set to match the department table. 

o If the item is being added or the department is being changed and the 
Dept Override flag in the SIL file is Y, the department flags from the 
department table will be applied and then overlay those in the SIL 
file. 

o If the Dept Override is explicitly sent as a N, we will refresh the 
itemizers from the department table. 

o If the Dept Override is explicitly sent as a Y, we will set the 
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additional flags as sent in the SIL file. 
o If the Dept Override flag is omitted, we will accept any additional 

flags that are sent in the SIL file and the Dept Override will be set to 
Y on the item. 

2432 Resolved a problem where multiple allowances would create duplicate allowance 
batch records. 

2449 Change the display of the Invoice Number on the FM so that only significant digits 
are displayed, shortening the value by eliminating leading zeros. 

2453 Changed the login process for FM Item Maintenance.  Batch Apply Time is not 
prompted unless the user wishes the schedule the batch. 

2458 Resolved problems with printing Rascal labels.  Certain fields displayed incorrect 
information. 

2461 Resolved a problem where the FM application would crash when attempting to print a 
Rascal label with the field “Today”. 

2464 Changed FM Receiving application to allow the Supplier Category to be changed after 
adding a detail record to the invoice. 

2477 Resolved problems with SIL Batch Export where the Frequent Shopper fields were 
not being processed properly. 

2488 Resolved a problem where the Exclude Adjustments from GM set to Y was not 
properly Excluding Adjustments from GM and Profit calculations. 

2489 Removed the Adjustment Method Code from the drop-down display of the 
Adjustments (the description should be enough) and readjusted the field width on the 
screen. 

2492 Resolved a problem where cases were not reported properly on the Store Transfer 
Ticket report 

2495 Changed the way descriptions are handled when received in a SIL Change batch.  A 
change record for the Short Description will not now change the Long Description. 

2496 Changed item maintenance so that Item Form and Item Grid share saved queries. 
2499 Department Receiving invoices are now extracted with Item Receiving invoices 

during the invoice extract process. 
2507 Resolved a problem where the Valuation Report was not working when the Inventory 

Method was Current. 
2515 Resolved a problem with the Release Manager Report where Release and Error counts 

were improperly reported. 
2519 Resolved a problem where SIL Batch Export would return an error if the batch 

description, after SBE – is pre-pended to the existing batch description, was longer 
than 50 characters. 

2529 Added logic in SIL processing to handle the Prohibit Qty|Assume Qty|Force Qty flags 
properly. 

2530 Added logic in SIL processing to handle the Vendor Cpn Flag|Bonus Cpn Flag|Store 
Cpn Flag flags properly. 

2532 Resolved a problem with SIL Batch Export where the Enforce Qty flag was not being 
exported when set to Inhibit.  The logic is as follows: 

Enforce Qty Value (RBO) SIL Field F85 SIL Field F102 
0 – None 0 0 
1 – Enforce 1 0 
2 – Inhibit 0 1  

2534 Resolved a problem where new order packages with no cost or adjustments are 
created when the Supplier ID, Case Pack Size or Order Code is changed.  A new 
Order Package will still be created but the current cost/adjustments will be copied 
from the existing order package to the new one. 
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2536 Resolved a problem where Cost Discounts were being exported in the SIL Batch 
Export application incorrectly.  Cost Discounts are not now being exported. 

2539 Resolved a problem where multiple costs for the same start date, one with a Cost 
Break of 0 and one with a Cost Break > 0, will both be processed. 

2544 Resolved a problem where Stock Count Import – added as a patch to 4.3.3 – did not 
handle EAN-13 items correctly. 

2545 Added an index for Item Group Code. 
2546 Resolved a problem where errors were generated when saving an invoice. 
2547 Resolved a problem where items on file on the POS but not in RBO were not being 

added to RBO when temporary maintenance was being used. 
2548 Resolved a problem where items were not printing in Chronological Order when the 

global parameter is set. 
2549 Resolved a problem where customers were being asked to choose Order Packages 

when multiples existed for a supplier though one of them was the Primary even 
though the global parameter Use Primary Order Package if Multiple Pkgs was set. 

2559 Resolved a problem where the Price End Date was not populated with the batch end 
date when printing batches from batch manager. 

2565 Resolved a problem in FM Receiving where an error was generated – Error 
determining inventory on hand time to update.  Violation of Primary Key constraint 
PK_DEPT_TOTS cannot insert duplicate key in object dept_totals 

2584 Updated the cost display on the invoice to include a comma separating the 1000’s. 
2591 Changed logic in file sync to exclude leading and trailing spaces when comparing 

descriptions.  This was returning problems when they really didn’t exist 
2592 Resolved problems where Item Maintenance returned occasional SQL errors when 

attempting to open SIL batches. 
2608 Changed the logic with processing SIL so that costs sent without a cost date are added 

with the SIL processed date as the cost start date. 
2609 Lined invoice numbers up more legibly on the Supplier Recap Report 
2622 Resolved a problem in Back Office Tasks where the scrollbar was not displayed when 

more than 14 lines are displayed in a 800X600 resolution display. 
2649 Made changes to the Stage process so that Order Package information will be applied 

properly when not in a ‘winning’ batch. 
2662 Resolved a problem where typing a Primary or Alternate directory for RBO Backups 

did not save the changes.   
2675 Resolved a formatting problem with Inventory Management reports. 
2676 Resolved a problem where the GM% was formatted incorrectly in Store Transfer 

reports. 
2682 Resolved a problem when credits/bottle deposits/return on debit were not being 

reflected using the /sub command on the FM’s. 
2686 Changed item maintenance so that when an item is added and fields are defaulted, like 

the TGM%, Pass-on % and Min. Auto. Price Change, from the Supplier record, the 
fields are not marked red, as if they were changed. 

2691 Resolved a problem where temporarily changing a retail on an invoice to 0.00 also 
changed the cost for the item to 0.00 

2692 Resolved a problem where, when you changed an adjustment with no end date, the 
end date was being set to the ‘today’ when it is released. 

2697 Resolved a problem introduced with 4.3.3 MU13 where only one Receiving session at 
a time could be opened. 

2698 Resolved a problem where items deleted from a suspended invoice continue to show 
up in the invoice. 

2701 Resolved a problem where Review/Edit Batch was causing display problems in Grid 
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View 
2708 Resolved a conflict between StoreLine and ISS45 versions where an Amount Off 

promotion is handled differently between the two releases.  The second threshold must 
be 1 on ISS45 and 0 on StoreLine 

2711 Resolved a problem where multiple reports on the same Back Office Task were 
displaying randomly during and edit of the BOT 

2734 DBConvrt.exe was modified to follow the department override logic written for 
ScanMaster, checking the parameter to determine how the flags should be set. 

2735 Added an Icon for a blank tool on the Batch Manager Toolbar.  A report process was 
available in the screen, but no icon was associated with the button. 

2738 Changed FM Flexible Data Collect so that the Inventory On-Hand is NOT updated 
when simply collecting the data.  We have written new features to handle this more 
correctly. 
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Additional Considerations 
When an item’s scale flag status changes within a reported period, the current status is 
used.  Any movement stored for the item with the non-current status will not be reported.  
For example, if a 5-week movement report is printed and within that period, the scale flag 
is changed on an item from Y to N then back to Y.  If the current record indicates that 
this is a Y, then any movement for the item while the status was N will not be reported.  
However, if the current flag is changed to N, then movement for the item while the status 
with N will be reported and the movement for the item while the status is Y will not be 
reported. 
 
An error will display on an ISS45 V7 system and item maintenance will close if an item 
is attached to more than four promotions, whether they are in effect or not.  Until this is 
resolved, items should be unlinked from expired promotions before linking to new 
promotions. 
 
When an item is set for an amount off per item discount on V7, an Order/Level 
promotion is created.  If multiple items are linked to this promotion, the customer will 
receive the discount for the items, but when movement and sales are pulled back to RBO, 
the discount amount for the entire promotion is applied to the last item scanned.  This is 
true whether the promotion is linked within the ISS45 promotion screens or from within 
RBO. 
 
Since FM Flexible Data Collect is a data collection program only, there is no facility for 
checking the validity of the data provided.  If the data fails to import into Inventory 
Management, the only indication that something is wrong will be missing data and 
information in the logs. 
 
When typing a pathname in FM Flexible Data Collect for output file, the path separator 
must be the DOS “\”, not the division “/” symbol. 
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ScanMaster Considerations 
The Adjective Code table is defined and maintained on the ScanMaster server.  While 
RBO may set an item to use an Adjective Code, when the movement is pulled, the 
Regular Sales value is calculated against the unit price of the item.  Thus, if an item has 
an Adjective Code as below, the item will show a “loss”: 

Level Price at level
1 1/1.00 
2 6/1.75 
3 12/3.25 
4 24/4.75 

If a cashier rings up a single item, the price is $1.00.  If they ring up 24 items, the price is 
$4.75, however since RBO does not maintain the Adjective Code table, the price will 
show a “loss” of  $19.25.  The actual movement and sales will be correct, but the 
calculated Ad/Loss value will be wrong. 
 
The ScanMaster feature to provide Like Item pricing is not supported in RBO.  Instead, 
we have implemented a general Item Group Code Pricing feature (see What’s New in 
4.04.00 above for a description).   
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